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Risk Disclaimer
High Risk Investment

Trading FX or CFDs on margin carries a high level of risk, and may not be suitable for all investors. The
high degree of leverage can work against you as well as for you. Before deciding to trade you should
carefully consider your investment objectives, level of experience, and risk appetite. The possibility
exists that you could sustain a loss of some or all of your initial investment and therefore you should not
invest money that you cannot afford to lose. You should be aware of all the risks associated with FX/CFD
trading, and seek advice from an independent financial advisor if you have any doubts.

Retail Trading Realities Market Opinions

Any opinions, news, research, analyses, prices, or other information contained on this publication is
provided as general market commentary, and does not constitute investment advice. Retail Trading
Realities will not accept liability for any loss or damage, including without limitation to, any loss of profit,
which may arise directly or indirectly from use of or reliance on such information.

Internet Trading Risks (VPS)

There are risks associated with utilizing an Internet-based deal execution trading system including, but
not limited to, the failure of hardware, software, and Internet connection of your chosen VPS provider.
Since Retail Trading Realities does not control signal power, its reception or routing via Internet,
configuration of your equipment or reliability of its connection, we cannot be responsible for
communication failures, distortions or delays when trading via the Internet.

Accuracy of Information

The content on this publication is subject to change at any time without notice, and is provided for the
sole purpose of assisting traders to make independent investment decisions. Retail Trading Realities has
taken reasonable measures to ensure the accuracy of the information on this publication, however,
does not guarantee its accuracy, and will not accept liability for any loss or damage which may arise
directly or indirectly from the content.

Please remember that past performance may not be indicative of future results.



Copyright disclaimer

RTR Momentum Trend © (2023) Expert Advisor and all source code are owned by Retail Trading
Realities Ltd (UK), All rights reserved.

Any attempt to decompile, modify, reverse compile, reverse engineer or decrypt RTR Momentum Trend
© Expert Advisor .ex5 file, is prohibited.

Any individual or any entity (sole traders, LLCs, Ltd companies, websites, online communities such as
Reddit, 4shared, Discord and Telegram groups) other than Retail Trading Realities Ltd attempting to
sell, transmit, host, or otherwise commercially exploit © 2023 RTR Momentum Trend EA is breaking the
law, i.e. software piracy is a Federal Crime in the USA.

Where possible, Retail Trading Realities Ltd will take legal action.

Retail Trading Realities Ltd only sells RTR Momentum Trend © Expert Advisor on MQL5.com, if you
have received it elsewhere please get in touch.

e DM me on MQL5.com
e RetailTradingRealities.com
e contact@RetailTradingRealities.com



Description
RTR Momentum Trend Expert Advisor for MT5.

The Expert looks for a Trend and Momentum.

It is Multi-Time Frame (MTF), it uses 3 time frames; Highest Period, Middle Period and Lowest Period.
There is a 2 Time Frame (TF) option as well.

The Higher Period — is the anchor timeframe, the expert will look for a trend and momentum on this TF.
The Middle Period — looks for a pullback (ignored if 2-TF option is true)

The Lowest Period —is the chart that you attach the EA to (important). Stop Losses and Take Profits are
calculated from this Chart.

This is a top down system, Higher time frame confirmation, Lower time frame entries, Higher time frame
exits. Small stop losses and larger take profits.

Momentum - Expert Buy when Higher time frame is already in a well-established up trend. Expert Sell
vice versa.

RTR Momentum Trend Expert Advisor works best, using diversification, that its’ intended use. EA
placed on multiple tickers, on multiple timeframes. That way we smoothen the equity curve, reduce
drawdown, have more trades, better for our statistics. It is suited to tickers that trend.

Indicators used:

- RTR Trend ©, a custom in house indicator, is a standard deviation of price indicator, with a few extra
filters, and better MA Smoothing.

- Volatility Bands (standard deviations)

- Multiple moving averages.

- Angle of SMA,

- ATR, Average True Range.

- % of ADR, Average Daily Range.

- So yes, there are lot of calculations.

Philosophy:

RTR Momentum Trend EA is inspired by the works of author Michael Covel, traders Richard Dennis,
William Eckhardt, and Richard Donchian - Trend Followers. However this EA executes trades on lower
timeframes, does not rely on the trailing stop for Take Profits (there is a trailing stop), makes no attempt
to time the markets.

Trend Following has been unpopular in mainstream financial publications for some time.

“If there was a strategy that I would want to employ right now, if
someone put a gun to my head, I'd say simple trend-following
strategies,” Jones said. “They are not too popular today. ... They

will probably do very well in the next five to 10 years.”

Paul Tudor-lones 03/05/2022 CNBC Interview https://www.cnbe.com/2022/05/03/paul-tudor-jones-says-he-cant-think-
of-a-worse-financial-environment-for-stocks-or-bonds-right-now.html




| am predicting that trend following is back, new divergences caused by recent higher interest rates,
means old correlation models won’t work. We have only just recently come out of a 14 year worldwide
low interest rate regime in 2022. This EA is for traders who are fans of trend following.

RTR Momentum Trend EA Features:

> Magic Number (Expert unique ID).

> Max Spread Filter.

> Custom Comment.

> 3 Time Frame / 2 Time Frame option.

> Direction - Long only / Short only modes.

> Position sizing; Fixed Lot, Percent Risk, Fixed Dollar Amount.
> Profit Threshold, (a multiple of Stop Loss).

> Day of Week Filter.

> Time of Day Filter.

Other:

> Online/PDF Manual.

> . set Expert Set files.

> You must Read the Manual, for RTR Momentum Trend EAs’ intended use.
> Max, 10 Activations.

> Works on MT5 Hedging accounts (not Netting).

> Assumes US SDollar deposit account.

How does RTR Momentum Trend EA compares with Grid/Martingale :
Advantages/Disadvantages:

> No Grid/Martingale.

> Every Trade has a Stop Loss.

> Take Profit a lot larger than Stop Losses.

> Low Leverage is perfect. 25:1 is more than enough.

> Adds into winners (not losers)

> Good results on Multiple Time Frame settings.

> No negative progressive lot size increments.

> After a loss, next trade risk will be smaller and so on.

> Ugly Upward Equity curve. (Diversification can smoothen out equity curve - read manual.)
> Low Win Rate 20%.

> In a Drawdown 80% of the time.

> Minimum $10,000 personal Account or Prop Account (on Lowest Risk Setting)
> Perfect for Darwinex Accounts.

If you like what you see, do not Buy Now, download the Demo first, use the MT5 Optimizer using your
Brokers tick data, Read the EA Manual (all of it). Rent it, then if satisfied purchase the full package. Once
the EA is activated MQL5.com cannot give a refund. MQL5.com handles all sales / refund process.



Welcome
Thank You for downloading the Demo of RTR Momentum Trend © Expert Advisor (EA) for MT5.

This guide will demystify the strategy, the EA settings and if you have not used EAs or MT5 before, this
manual will be an educational introduction to the MT5 Strategy Tester and Optimizations.

Attach EA to Chart
MTS Terminal>File>New Chart> USDJPY

MTS5 Terminal> View > Navigator > to find EA
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Either: Drag and Drop EA to Chart or Select EA Right click > “Attach to Chart”.

Under the Common Tab, click ‘Allow Algo Trading’.

UTF_USDIPY 1.00 = x
Common  [nputs
UTF_USDIPY 1.00

' Copyright 2023, Retai Trading Realities Ltd.

[ Aliow modification of Signals settings

E Allow Algo Trading

If you cannot find your Ticker Symbol, MT5 Terminal > View > Market Watch...> right click any ticker
inside Market Watch > Show All,
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After you have all your desired symbols, return to Market Watch> right click any ticker > Hide All.

This way Market Watch is not running in the background using up CPU resources, looking at ticker
qguotes you are not interested in.

(Also While you are in Market Watch > Right Click any ticker> Columns > Spread. Shows all Bid-Ask
spread in points.)

You must Attach EA to the chart period, which matches the Lowest Period in EA Settings. So if Lowest
Period = M15, you must attach EA to M15 chart.

.set Files (Expert Set Files), How 2 load
.set files have saved settings, pre-sets.
.set files will only work for the EA it was designed for.

| have provided a zipped folder of .Set files, see https://MQL5.com/en/users/PKSN/Publications.

o0 AUDJPY.M15

Simply double click on the EA (Teacher Hat Icon) in the top right hand corner, of the chart.
EA Settings will open up > Inputs Tab

Scroll to the bottom of these settings, click ‘Load’.



| Load
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If you want to save your own .set file, click Save. | like to name it like so
“lowest_timeframe_Symbol_3TF” = “m15_NDX_3TF” meaning EA is attached to Chart Period M15,
Nasdaq NDX CFD, 3 Time Frame setting.



Warning Do Not Set any chart period = ‘current’

| AUDJPY_M15_Fixed_Long_Only 1.00
ow HJ
o 4 Common Inputs
a¥ .

a Il*l Variable

01 order_magic

Time Frames, if 2 TF only, then use Anchor _TF ...
* Two_TimeFrames_only

& Anchor_TF

= First_TF

& Second_TF

Anchor Indicator Settings

When switching charts, if a signal has just been executed, the algo will make new trades, based
on the time frame you switched to. If the EA is meant to be on the 15 minute chart, then set
Lowest Period (‘Second_TF in this example to ‘15 minutes’), never ‘current’.

How the EA is coded, OnBar( ) vs OnTick( )

void OnTick()
{

This EA, is coded OnBar() , some programmers call it NewBar(), what that means is the script/code is
executed once on the Open of every new candlestick (bar). This is a more reliable when it comes to
Back testing and true outcomes. The RTR Momentum Trend Expert executes code on every new bar
opening of input ‘Lowest Period’.

{

ew local variable to hold the current open time of the furthest right bar
datetime rightBarTime = iTime(_Symbol, Second_TF,9);

heck if furthest right bar has the same open time as our
if(rightBarTime != gBarTime)

{

gBarTime = FightBarTime;

OnBar();
This is in contrast to MT5 default for executing code OnTick(), On Tick means the code tries to execute
on every new price quote that come in. Each new change in price quote, is called a ‘tick’. It tries,

because if a code is being executed and a new tick comes in, while that code/script is being processed,
the MT5 terminal will not execute the code again until a new tick comes in. That is it skips the tick that
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came in while the code was being processed in a Live Market. However when running a back test in the
Strategy Tester, MT5 assumes at every tick the code will get executed.

Most martingale/grid, tick Scalping EAs on the market place are coded ‘OnTick()’, which can be
problematic, in a real live trading .

https://www.mql5.com/en/docs/event_handlers/ontick - it’s really not that interesting.
How the EA is coded — Magic Numbers

Almost all EAs have an Expert ID called Magic Numbers.

Set this in the Inputs option of your EA.

Magic Numbers should be at least 6 digits long.

They should be integers (no decimals) i.e 1234567890.

No Characters AaBbCcZz!”?"%. otherwise EA will catch an Error.

Common Inputs

Variable Value A

01 ExpertID Magic Number 142895

Magic Numbers are important so MT5 terminal can distinguish, which trades belong to which strategy.

A strategy is - every time you attach an EA to a Chart. Every time you attach an EA to a Chart, make
sure you give it a new Magic Number i.e. 7879532, 6547023, 999111.

You also need to keep note, of which strategy has what Magic Number.

Magic Numbers are important to this EA, users are expected to have multiple strategies. The RTR
Momentum Trend Expert Magic numbers are used to monitor, adjust and close out positions. So if 2 or
more strategies have the same Magic number, all trades will be closed out at the same time and we
don’t want that!

To view Magic Numbers of your trades, in the MT5 Terminal > View> Toolbox > Trade (Tab )> right click
cursor anywhere on the Trade Tab > Columns > Magic Number.
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Strategy Tester & Optimizer in MT5 — What is it?
MT5 Terminal > View > Strategy Tester

4000017480 - Darwinex-Live - Hedge - Darwinex
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To back test an Expert Advisor, you can run a Single tests, and Optimizations in MT5 Strategy Tester.

Optimizations will look at the input parameters (see Inputs Tab of Expert) you have selected and all the
values you wanted the EA to be tested for. It will test all possible combinations of settings. Be careful it
is recommended you choose only up to 3 inputs for optimization. The more inputs selected the more
chance of ‘curve fitting’.

If you choose too many inputs and step settings, i.e. 2,000 combinations, MT5 will revert to a ‘genetic
algorithm’, to find best settings, it won’t test every combination. It will test a sample and try to find the
best settings using their in-house secret algo.

Espat: | RTR_LTDVUTF_GOLD sx5 | e | @
Symbal: |KALISD < | 2 w
Date:  Custom pencd | [2eo o - | [nmr -
Forward: | Na <] [z
Delays: |23ms o emae sippage and requotes dung trade execufion
Modeling: |Dipen prices only ¥ | [t in pips for faster calculsbions

Depost: [10000 | [Uso ; 13 | leverage

Optirizstion:  Fast genetic based slgodthm w | | Profit Factor max

Strabwgy Tester

Settings | Input Backtest rapt Optirnization Result Agent Jaummal Tof T = 00:00:16 f 000016 Start

Choose Symbol and the Chart Period you would have placed the Expert Advisor on, if it were live
trading.

3

The Yellow Dollar sign Icon s very important, to new users of MT5 strategy tester.
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You will need to click on this Icon, to change the selected Symbols’ defaults for a correct back test. Its’
default is either; (No Leverage) ‘CFD’ and ‘Forex No Leverage’. Here you will change it to ‘CFD Leverage’

or ‘Forex’.
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You can also change the default Direction from ‘Full Access’ to ‘Long only’ or Short Only’, this change in
direction set here, will only work for back tests and optimizations, this will not change in Live or Demo

trading.

Modelling Data: using Open Prices (the RTR Momentum Trend Expert is coded On Open Prices —
OnBar() ), or simulated ticks called ‘Every Tick’, ‘Every tick based on Real Ticks’ include Broker historical
Bid-Ask Spread, there is also a 1 minute bar option for the data.

Note: Back tests that have Real Tick selected will take a lot longer than on ‘Open prices’ modelling.

| suggest Optimizations using ‘Open Prices’, then Run Single Back test using ‘Real Ticks’.

T

.Y

Start Step Stop Steps

START, STEP, STOP:

START, is the first value of the input that will be tested.

STEP, is the increment, it will add to the previous value of the input that was tested, and will run a new
test.

STOP, is the Last value of the input that will be tested for.

So in this Example we have selected only 1 input for Optimization, Profit Threshold.
We Start at 8, STEP (increment)= 2, FINISH at 20.

We will test Profit Threshold at; 8, 10, 12, 14, 16, 18, 20.
And there are 7 Passes (8 to 20).

13



Select axped = || View previcus optimization fesiils

Vanable Value Start Step Stop Steps ™
[ ExpeniD Magic Mumber ET1E84 353553 35555
Time Frames, if 2 TF only, Middle Period will be ignored
[] 2 TimeFrames Oniy false fabse true
[[] Haghest Periad 1 Day
[[] Mideile Period - ignared when 2 TimeFrames = true 1 Hour
[ Lowsest Period - must attach EA to this chart 20 Minutes i Hour
Stop Lot Sizes
[[] Fixed Lok size £.g 1.32 lots, ignored f ‘Risk %' 15 used 0.1
[ ‘Risk %' per Trade 1.00 = 1% Risk, 0.50 is half% 1.0
Fixed SDollar Amount. Leave as 0 if not intended to use
[[] Fixed $0oflar Amount per Trade. o
) Take Profit Multipher
Prefit Threshald B 2 20 7
Direction - Both, Long only, Short anky
[ pirection Bath Bat hort_Or
Custom Trade Comment
[ custam camment
Spread Filter
[ Maximum Spread 60
Day of Weelk Fiiter
[ Sunday true fakse true
] Monday true fakee true
[] Tuesday true Fatse
[] Wednesday true fakse true
[ Thursday true faise true
[] Friday true fakse trus
[] Saturday true
§ Hour of Day Filter
= [ Start operation hour D00
E 1 i 34 W Y3 b
f Cveview | Settings i s | Agents | Joumnal N2 of 112 - 00:05:26 7 00:0%26 Stant
™ | Select axpen. | Visw pevious opSmization results v Selsct eseon v
Pass = Result Profit Totsl trades Profit factor Expected payoff Drawdown % Recovery factor Sharpe ratio Profit_Threshold
o §1104.62 318 181 180.1 34.14 35 8
1 339 1.85 30.16 3.05 1.5 10
2 U7 2.2 3.48 207 12
3 40 1.58 aTm 0.85 4
4 47 1.59 47 0.98 16
i 5 439 1.74 18
i. 6 144 93071.71 454 144 1.00 20
E werview | Settings | Inputs | Optimization Results [ Agents | Journa Tof 7 - 000011/ 00:00:11 Start

Source: https://www.metatrader5.com/en/terminal/help/algotrading/strategy optimization

How 2 optimize this EA using ‘Open prices’ in MT5 Strategy Tester

| would only optimize for a maximum of 3 inputs:
e Middle Period (ignored when in 2 timeframe mode),
e Lowest Period,
e Profit Threshold (this must always be a selected input in an optimisation)

| would keep Higher Period fixed equal to Daily D1 or Week W1.

Optimizing for the other inputs such as Direction and Day of Week, Hour of Day filters, will be discussed

in the next section.

| optimise using the following settings pictured here,
Modelling: Open Prices or 1 minute OHLC bars

Slippage: choose 30ms,( my VPS has a Ping of 8ms) ,this is ignored when using Open Prices modelling,

but will be used later in Single Tests.
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Select ‘Fast Genetic Algorithm’ and ‘Profit Factor’.

If my Ticker has several profitable results in the optimiser, | will choose a handful of results and Run
Single Tests using “Every Tick Using Real Ticks”, just right click on the result and “Run Single Test”.

«  Prafit Factor Lm
« Expected Payolt
e
#  Drawdown %
+  Recovery Factor LTS
+ Sharpe Ratio
.
Oiptirnized Inputs J
Filters ¥ BE
wi Export ta XML (S Odfice Exeel) Lo
(7 Expost Optimization Cache File s
e I (& Impert Optimization Cache File "
T * 3 & § & 7 i ¥ W u i W u O O = B & ¥ B B ¥ = =
# Auto Switch to Results
EURUSDLHT WSDCHEHT | GEPUSD Dady | USDURY.HE | XAUUSDHI
e - . Auito Seroll L
| Sesect et | Select crbenion bt
! + Auto Amange A
Pass - Gid G i Recovery factor Sharpe ratio Profit_Theeshold
L T
5
& 454 144 20500 4747 1.0 20
4 47 1.56 TR 707 -L 16
1 338 1.85 X751 318 305 5 L]
3 A0 1.58 =3 47m (L 14
i o 318 181 16071 14 8
& Over Tof 7 - 00:00:11 /000011 [NISHSAE
Defavi Ll - 2156 / 339 Kb

“Every Tick Using Real Ticks” is the historical data feed from your broker, with Bid-Ask Spread at every
tick, where there are gaps in the data it will be filled with “Every tick” which are simulated from 1-
minute OHLC Bars . (For more info MQL5.com help section should have the entire science of it).

"
Spet | ATALTONUTF GOLD =5 e
MALILIST Mae Ly
e |Cnsbhiv prefese
Faresrd: |
Deelays: | 23m = en -
Madafmg | By tick hased on resl ficks
- | 10000 usg
mazation | Dissbied nsusl mode with fhe despley of charts, rdicaion and trades
g Chepreievs i Settings I Inputs | Geaph | Optimization Resufts | Agerts | Joumnal m

RAVUSD
B0 0y A———

Graph | Tptemciton Trsn | Lpeee . 00084 000818 |
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* | History Cuality 2% | A

Bars 101186 Ticks 434245738 Symbals 1
Initial Depesit 10 000.00
Total Net Profit 14830100 Balance Drawdown Absolute 53628 Equity Drawdown Absolute 184.85
Gross Profit 287 504.26 Balance Drawdown Maximal 21 248.30 (11.77%) Equity Dvamciawn Maximal 44 136.64 (26.44%)
Gross Loss -138 20328  Balance Drawdown Relative 33.49% (10963.69)  Equity Drawdawn Relstrve &0,15% (11 773.80)
Profit Factar 208 Expected Payoff 43783 Margin Level 05.66%
Recavery Factar 338  Sharpe Ratia a1 I-Scare -13.37 (99.74%)
AHPR 1.00&8 {0.88%) LR Comelation (eF::] OnTester result 0
GHPR 10082 (022%) LR Standard Emor 1823450
Total Trades i Shert Trades {wen %} 85 (26.32%)  Long Trades (wen %) 286 (26.02%)
Total Deals 682 Profit Trades (% of total) BI(@BI0%]  Loss Trades (% of total) 252 (T3.90%)
Langest profit trade 1208577 losstrade -2 482.83
BAverage profit trade 323038 loss trade -544.15
Maximum 12 (B4021,61)  consecutive losses (5] 35 (-9 5T6.61)
a Maxirmal 2402181 (13) consecutree loss (count) -1 133,20 (11}
'E Boverage 5 conseculive lrsses 13
E Owervies | Settings | |nput | Backtest [ Graph | Optimization Results | Agents | Journal 00:08:14 / 00:08: 14 Start

The ‘Every tick using real ticks’, will take some time, as it is more detailed. This result will always be
worse than Open Prices Modelling; here we had Open Prices $203k vs Real Tick $149k profit, from a
$10k deposit. Do not fear too much, | have actually found the real executions are near to Open Prices
modelling. However we have to think of worst case scenarios, rather than be too hopeful.

Optimization - use StrategyQuant.com’s ‘Quant Analyzer 4’ to filter Days and Hours

https://StrategyQuant.com > download and install Free version of ‘Quant Analyzer 4’. | do recommend
eventually purchasing the Pro Version for any one serious about algorithmic trading.

Export your Report from MT5 Strategy Tester by right clicking anywhere on the ‘Backtest Tab’, make
sure it is .html file.
(MyfxBook.com, also has an excellent analysis tool unfortunately does not work for MT5.)

‘Quant Analyzer 4’ will provide extra Statistics for your strategy, such as Monte Carlo simulation,

Analysis by direction, merge tests into a Portfolio, too many to mention, they have it covered.

Click this, locate your .html file and follow the instructions.

Look in Ratad Trading RealSies LTD v 4D 8

GEPUSD_day_fiter_ReporiTester-4000017480.hei

Cote
TET

Trade pericd by | Zme 7 | Sar

We want Trade period by open time.

Example GBPUSD back tests were successful with a 5yr return of 78.63%, however Trades opened on
Monday, Tuesday, Wednesday we unprofitable and gave us Drawdowns. All of our profitable trades
came from Thursday and Friday. So we return to our EA Inputs and make Monday, Tuesday, Wednesday
= False. And Run our Tests Again. We now have a better returns, better drawdowns as well.
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gty | Bacivem Ic.ua I g o oty | Lpeemy |

GEPUSD_day,_filter_Report Tester-300007 7480

Cuerview  Lstoftrades  Equey chan | Tradeanalyss | Semngs | Fortiobo comention | Open baimnces

v n-m|: L s Immwﬂl‘i

WE ke [ | Anatysis for ail years

Nz Profe Lang va Short PiL
& TEE1 5 |
PUL by wesskday b ranm |
5 -850
FEI9E BE
trisih sam
420013 o
41804 Ll aam
52681 58 ool e
1w
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g
|
i | -
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5 |
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e
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IPIL f Waakday
Closa
Diaimin Clnar &8 Lrenin Porfick lﬁdﬂ Chocse view  Defaut '
GBPUSD Optimizations (before Filtering Days).
Pass Result = Profit Total trades Profit factor Expected payoff Dirawrdiown 5 Recovery factor Sharpe ratio
& 127 2843537 452 127 &) 47,84 0.85 3
5 124 2113726 452 124 4674 43.8% 0,76 81
2 113 121843 | 416 113 17.35 4801 048 ok
a4 113 TTT0.50 62 113 1682 51.05 (2] o
3 106 208254 a2 1.06 B.75 5289 022 4
o 1084 137238 n 104 44 38.23 .22 13
1 103 RER D) 3R 1.0 238 65.59 0.08 0

Profit_Threshold

n
18
12
16
4

a
L]
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Filter Day Inputs:

Variable Value Start Step Steps ~
[] Meximum Spiesd 50.0 5000
Day of Week Fiter
[ Sundsy false false true
[] Menday fakse fakse frue
[T] Tuesday false falze true
[ Wednesday tabke false true
[ Thursday true false true
[ Friclay (_;ueJ false true
| [ Seturday false false true
Hour of Day Filter '
[T] Stast operation hour 00:00 D0:00
[] Last operation haur 2300 0000
E Overview | Setting: | Inputs I Backtest | Graph | Optimustion Results | Agents | Journal

GBPUSD Optimizations (after Filtering Days), all results are better:

*|5elaﬂaui| vmwmm v-.mmaun -
Pass Result = Prefit Total trades Predit factor Expacted payoff Drawidiown % Recovery factor Sharpe ratic Profit_Threshold

] 3184320 152 211 7002 4468 1.43 18

4 SOTSE.20 180 210 26715 463 147 18

2 32706.5% 182 208 176.96 621 1.60 12
|8 57869 LS 2.0 263.43 286 135 20

1 1.3 19506.35 180 191 110.5% 143 10

i 2 267T93.86 188 182 14252 4450 114 14

L] V.69 1371659 (=1 169 2364 5T L2 a

New Single Test on same settings, with new Daily filters:

CBPUSD st suy mee
TDUB% oy test99% Quamy

Wil AR NAAAST  JWASLI NS RG] JWBSAL MBS NILD NN  JULILMA Sl BNl MLl
Overem | Semings | inpwts | Backsest | Gragh | Optemstion Bosuity | Agests | horns

After_GEPUSD_day_Tilter_Report Testor-400001 ra80

Mante Carlo simulation Use Fandomize trades arder
Humber lor smudsions 100 % F  Randomize trades oder wih EXBct meghod 4 Misc |
S ] Randomiy skip trsdes wih 1 % probabiity Metnog Exagt

‘Whal is Wone Caric mimulabon and why is it mpartand®

Mmmm Monts Cardo Chart  Fiskofren Predet | Yendy
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Both MT5 and FXBlue.com have an hourly and daily trades summary statistics, however they only report
on when trades were closed. Which is not helpful, we want to know when to open trades.

Optimization - use ‘Quant Analyzer 4’ to filter Direction.
You can use Quant Analyzer 4 to filter for direction.

| would not filter for direction on tickers that were unprofitable in a standard test that used both
directions.

How this EA is intended to be used — multiple strategies

The RTR Momentum Trend © Expert Advisor, is intended be used across multiple tickers/symbols and
multiple time frames. The reason for this is that we should never rely on 1 ticker symbol, back tests are
no promise of future results.

Diversification, the more RTR Momentum Trend © strategies we add to our MT5 Terminal, we must
lower our risk on each strategy, we must never have more than 20-to-1 leverage at any time, so that
includes if all strategies are executing trades on the same day. Diversification reduces maximum
drawdown.

Diversification — reduces drawdown Portfolio example

The more uncorrelated strategies added is likely to reduce drawdown.

Using ‘Quant Analyzer 4’ in a few clicks you can create portfolios, see your new reduced maximum
drawdown.

Load report

As explained before, load around 4 to 5 MT5 Strategy Tester tests (.html files) into Quant Analyser 4.
(Make sure they all cover the same Date Time period - they don’t have to but better).

| have loaded 4 strategies NAS100, BTCUSD, GBPUSD and lastly XAUUSD (GOLD).
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Gold_EYR_Compound_All_StrategyTester_Again_anomaly

Overvew | Listoftrades = Eoulychant | Trade onsiysis | Seftings | Portiolo commation | Opan baances

Data  XaUUSD v ! m]us L 5 | Tampiaie 5O Dataut ek
—_— ol
. opt TOTAL PROFIT # OF TRADES EHARFE RATA FROFIT FACTOR RETURN / DO RATID Wikdahis PERCENTAGE
e 38T 0.15 2.02 39 17ATS
) $ 79147.96
— - v N %0 DALY AVG PROFT MONTHLY VG PROFIT AVERAGE TRADE
2iny PROFIT IN PIPS 21773500 PIPS
: ' $203.99 $2261.37 $215.86
TEARLY AVG PROFTT $27147.53 =
YEARLY AVG % RETURN 27143 % R EXPECTANCY SCOAE  STR QUALITY NUMBER 80N SCORE o
CAGR 54,85 % 106.25 R 2.58 1.56
STATS
Strategy ¥
Wina / Lesses Ratio 0 Payout Ratio (Avg Winloss) 974 Average #of Bars i Trade a
AMPR 0es Z-Score -14 53 ZProbabity HI%
Expectancy 2i588 Dievaton $1803 5 Macx Pos. Exposure iz
Seagraten r Days T2 Stagnation in % 4102 % M Lots Exposure 909
Trades
20! Wins [ #afLosses 304 # of Canceled/Expired [ Rl
I v
— - - ¥
Simple sirnleges | Portiobos |
[ Savev | Dsen | Ciescd | Crests Fortoie Choose view.  Deaut v Mansge
Strategy Name Symbol e profit Softrades % Wins Proft i Stabity  Symmetry Draw.. MaxDD. Winflos. RetDD Svg Win Avg Loss &
1 NAS100 Syr Compoundsd St NAS100 . §8096138 %22 2464% 148 077 % 4. 42E% 033 199 5238, S
Sirstegy Tasier 4H H1 5 Mn.. BTCUSD - Sm.ﬂ‘ 96 16.08% 118 0.48 % 55 E95% o1s 061 5283 5476
P2 aner GBPUSD doy_fter R..  GBPUSD § 5077489 10 o8 21 064 2246%  $9.  2102% 026 521 S22 534
God_BYR_Compound M St XAUUSD | §7%ia7 88 367 17T 202 0,42 B372% 83, 43R oM g £248, §-285
3 O
Fzady

| Seiestminges 4 Fooion 1 Montor [ | Used 26047 v8

As you can see above image, the last Strategy | loaded was XAUUSD.

Now focus on the bottom Panel

b

| Senpie sirateges | Portiios |

[ | save® | Deete || Ciear | CrestePodiolo  Seteo Choose view  Detaun v | Mansge |
Suraegy Namns Symibed Bet profe wolirades % Wins Profitfa.  Stnbiity Symmetry Draw. MaxDD. Windos. RsyDD.. Avg 'Win  dug Loss F.

B HAS100 5y7 Compoundsd S1... HAS100 . 58086138 422 24645 143 o % S4.  426% .33 199 $238.. $ 626
71 StrategyTester 44 H1 5 Mn BTCUSD § 5065 B2 696 0% 198 049 0% 1.3 9% 018 (1] s 476
] aher GBPUSD day fter R..  GBPUSD . S50774.88 190 08% 21 04 2245% §9. 202% 026 521 S48 5304
[T God 5YR Compound_A8SL.  XAULSD . 578147 96 367 ITAT% 202 042 BI7I% 82 4316% 021 38 £248., 5.256.

]

Ready

Hontar - | Used maziMe 5

aw.. MaxDD.. Wi | Simple strategies | Portfolos
4... 426% 0  SaveY | Delete | ClearAl Create Portioio
8... 59.8% 0 - '
Strategy Name Symbol .. Net profi
9. 21.02% 0 "]  NAS100 5yr Compounded St..  NAS100 . $8096°
D 43.16% 0 StrategyTester 4H H1 5 Min..  BTCUSD . $50385¢
After_GBPUSD_day_fiter R..  GBPUSD .. $5077s
Gok_SYR_Compound_AI_St..  XAUUSD . $7914

Notice Max DD % of all strategies is 59.8%,
mean average DD is 41.65%

Select All (strategies you want in the portfolio)
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Create Portfolio

| ;

Now it is a portfolio with Max DD of 24.9%, a reduction from an average of 41.65%.

Click this, it will merge all 4 strategies and take you to the Portfolios Tab.

_Sﬂmm“m_

) Save ¥ Portfolo ¥ Deieta Clear Al Set note
Strategy Name ... Symbol Ti.. Net profit #oftrades % Wins Profitfa... Stabity Symmetry Drawdo.. MaxDD..
M Portfoso (1) Portfoio A.. .. 8 261244.07 1675 18.99% 146 08 42.2% 5785.. 249%

| Simple strategies = Portfoios

[ savev || PotiokoY  Delete  ClearAl  Setnote
Strategy Name ... Symbol Ti..  Net profit #of tra
M Portioio (1) Portfolo, A.. ..  $26124407 1675

¥,

Double Click this blue text $261244.07 (Net Profit)

Now the XAUUSD (Gold) overview is no longer showing, now it is the Portfolio Overview, CAGR 49.75%:
' | [ st ' :-.I SI [ia) 1) - v

Portfolio (1)

Overvew  Listoftrades  Equitychart  Trade analysis | Sattings  Porfiolo cofrsiation  Open baiancss

Dbila  Forfioko ¥ | Da-mlL-s L 5 | Tempiste S0 Detoul v
-
‘.
TOTAL PROAT # OF TRADES EHARBE RATIC SHCET FACTOR BETUAN 2 D0 BATIO WINNING SERCENTAGE |
$ 251244 07 16758 0.13 148 3.32 18.99 %
= DRAWCOWN * CRAWDOWN DARLY AVG PROFIT UONTHLY AV PROF(T AVERADE TRADE
SOFTT I PIFS 106117311471
coints e el $ 78570.48 249% $234.72 $ 4354.07 $155.97
YEARLY AVG PROFTT  § 52255.08
YEAALY AVG L RETURN 13064 % ARNNLAL % MAX DT % R EXPECTANT R EPECTANCY SCORE STR QUALITY NUMEER SON SCORE
cach 5.75% 2 03ITR 12481 R 351 1.07
STATS
|
Strategy M
Wins / Losses Rafio 0y Payout Ratio (dvg Winfloas) B2} Average # of Bars in Trade -]
AHPR 213 ZScers 2938 Z-Protutity W%
Expeciancy 15597 Devistion £ 181641 s Pos. Exposuce =
Stagnation in Days m Stagration i % 1505 % Wk Lots Expasiss 16297
Trackes
- Aol 148 25kl sases. 135 &alla - n " I:'E
- — v
(2] Save * ok * Deletn Clear /2 Satncin Choose view  Defoult with M., v | Manege
: Sirategy Name Symbol Ti Met profit #oftrodes W Wne  ProStfs.  Stablty Symwsetry Drawdo. Max DD, Winilcs.. ReVDD . Awg Win g Loss Aw
ol T Portioka (1) Pofolo, A .. | $26124407 1878 1B99% 148 [T 23% S5, M9% 02 132 $281.. S48, O
R : =]

Simpe statsgies: 4 | Pofolos 1 | Mootor [N | (sed 106.00 ME B
—
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Equity chart
i > Click Equity Chart Tab

s
Turn on Drawdown, Select %

‘ Drawdown [ v | Vol

[ 1%
| P

E"“—“ to see % DD in a time series.
In %

Porifobo (1)

Overview | Listoftrades Equiychert = Trade pnslysis | Seffings Portiolo coneiation | Open baisnces

Data Porticlo . |Dum|: L s xm.fg smums.|n-m]}cu

Equity ($)
:

20

B L UM Dashit Bh AR A | (LR AT

Volume  Drawdaown (%l
g

““ aludl MUJLMJH_M ‘Whhi‘h.j ik

May2018  Sep2018  Jar2018  May2018  Sepd01F JeA-2020  MaI020 Sep-2020 Jan202Y Mee2021 Sep2029  Jand022 Mayd022  Sepd022

m:.l. YT j_llh l i L_..L._,h]|l.. _.II_J l Jl

— After_GBPUSD_day_filter_PlepodT ester400001 7400 — Gold_SvYP_Compaund_All_StateqaT eitei_Again_anamaly NAS100 Syi Cempounded ShategyTester = Pasttatio |
— SirateqyT ester 44 Hi § Minwte With Compounding

& - ¥

Ready m_mumwwg Lsest 238 5 v T

About those ‘uncorrelated strategies’ > Click on Portfolio Correlation Tab, to see if you strategies a
positively or negatively correlated (we want negative correlation in diversification, otherwise too much
risk).
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How to use with prop firms

Since Prop Firms no longer have a time limit, how | would use this for prop firms, is to look at my
predicted Maximum Drawdown over at least a 5 year back test. And divide that by the Maximum Loss
permitted by the prop firm, 10% for most, so if my maximum predicted DD is 24.9%, then | will divide
my risk percent per trade further by 3.00, though this would be very slow.

You can also look at your back tests and see where your portfolio of strategies, peak at draw downs, in
the previous example drawdown stayed under 18%, so getting in when DD is at 9% and then copy those
trades to your prop account, once that DD Threshold has been met. Does that make sense?

(I have a more suitable M5/M15 Intraday EA for the GBPUSD pair for Prop Firms, it has been on a low
DD winning streak since January 2022. | will put it up for rent. So check my MQL5 profile.)

Psychology — mentally dealing with drawdowns

This strategy has a low win rate, around 20%, which means you spend 80% of your time in a draw down,
you can have a series of losses, consecutive losses, especially when you have multiple strategies. They
can be all losing at the same time. Winning Streaks come quickly. So if you get cold feet or shaken out
during the drawdown and stop trading the EA, what is likely to happen is that you will miss the winning
streak. This EA does not Attempt to time the market.

Hopefully you have optimised, back tested and imported those tests into a program like ‘Quant Analyzer
4’, combined them as portfolios and know what to expect in terms of series of losses, Average DD and
Maximum DD.
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EA Settings:

Variable Value
[] ExpertiD Magic Number 142835
] Time Frames, if 2 TF only, Middle Period will be ignored
[-] 2 TimeFrames Only false
[] Highest Period 1 Day
[] Middle Period - ignored when 2 TimeFrames = true 4 Hours
[] Lowest Period - must attach EA to this chart 5 Minutes

If 2 TimeFrames Only = true, then Middle Period will be ignored. You only have to optimise for
Highest and Lowest Period.

The Lowest Period is also, the Chart you must attach the EA to. So in this example above Lowest
Period is 5 minutes. Attach this EA to M5 chart. Warning never set any period to “current”.

| Stop Lot Sizes
"2 Fixed Lot size e.g 1.32 lots, ignored if 'Risk %' isused 0.1
2 Risk %' per Trade 1.00 = 1% Risk, 0.50 is half% 1.0
Fixed $Dollar Amount, Leave as 0 if not intended to use

[0 Fixed $Dollar Amount per Trade. 0

o Fixed lot size, will be skipped over if ‘Risk% per Trade” or ‘Fixed Dollar amount’ is true (>0.0)
e If you do not want to use Risk % (percentage of Account Balance) must set it to 0.00
e If you do not want to use Fixed $SDollar Amount per trade set it to 0.

How to set - Risk percentage %,

‘Risk % per trade’ is the recommended setting for this EA, it equal to percentage of Account Balance. |
have included other options, ‘Fixed Lot size’ and ‘Risk Dollar amount’, i.e. if you want to risk $200 a

trade.

A Strategy is every time you attach the EA to a Chart. So if | have 7 charts with an attached EA, | have 7

strategies.

How to set each EA ‘Risk %’ percentage settings:

Number of Strategies Risk_percent % Risky Settings (are
(recommended double the
settings) recommended)

1 0.5 1.0
2 05+2 = 0.25 0.5
3 05+3= 0.167 0.333
4 05+4= 0.125 0.25
7 05+7= 0.071 0.142
n 05+n= 10+n=

24



The Risky setting of initial 1.0%, is the maximum risk | am willing to use on this EA. | would not use the
risky setting on STOCKs as there are Gap up and Gap downs.

Fixed Lot Size, SFixed Dollar Amount.

You will have to set this yourself, just know that you can have 6 open trades on each strategy and we
want to keep leverage well under 25-to-1.

| don’t want you to use this, but was suggested by my testers. | feel that using risk percentage of balance
is the best, because it stakes more as the strategy earns profits and stakes less when the strategy is
losing. The whole point of automated trading is to do less. Using these options one would have to re-
calculate often.

Magic Numbers (Expert ID)

Every time | attach the EA to a new chart, | must give it a new unique Magic number. Any whole number
(integer) at least 6 digits. 123456789. (No Letters or characters).

Direction — Both/Long/Short
Just set the Direction.
In the Experts Tab of ToolBox on MT5, you will get a printed message, indicating that:

“SELL Trades Only, symbaol=USDJPY, period=M30, magic=123436", when the Expert tries to Buy. (Vice Versa).
Depending on what Direction you have set it to.

How to set Maximum Spread filter, with examples.

The Brokers | am using is Darwinex and RoboForex (for Crypto).

Setting the Maximum Spread is sensitive to your broker. | like to use maximum of = 3 x normal spread.
Normal spread is just an approximation, of spreads during London-NY trading hours.

How to find your spread in MT5 Market Watch.

MT5> View> Market Watch, right click any ticker> Columns > Spread,
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4000017480 - Darwinex-Live - Hedge - Darwinex - |

Charts  Tools

o0 File Insert
~ -G

M1 Mi

Languages 4

Toolbars »

Mavigator | ¥ Status Bar

¥ Charts Bar
y L8 Symbols Ctrl+U
Depth Of Market L4

| *. Market Watch Ctrt+M

4+ Data Window Ctri+D

i1 Navigator Ctri+N

&= Toolbox Ctrl=T

I Strategy Tester Ctrl+R

| D Chats Alt+M

| €7 Reports Alt+E

5[ " Fullscreen F11
£ testing

Market Watch: 13:46:37
Symbel <

u EURUSD

4 GBPUSD

A USDCHF

A USDJPY

+ click to add

Wi

B 3000017480 - Darwines:-Live - Hedge - Darwine: - [USOY, H4]
00 File WView Incert Charts Took  Window  Help

vl 0| e B & ] Algo Tading  [3) Mew Order | 1 (1
MIOMS MIS M0 HT B DL ow Mh | TR 4 = S 2
Market Wtch: 134433
Symibal = Bid Aak  Dally Ch.
4 EURUSD DSO3G.  1.0S033 b1
- -
gy [ Mew Order |
o I < Chart Window b
~ Tick Chant Fas
=3 Depth OF Market Bilts B

E Specification

) Popup Prices Fid
Hizle All | .
Show All Last Acerued Interest Bic
& symiis Culey  HightLow Initial margin Big
P b Valume Maintengnce margin Asl
Symboks [T g 'R i macon sl
= 1 Tima Initial Sell margin Lag
Use System Colers < Daily Change Lower Limit Last
Show Milliseconds ST UnpesCini ol
1 Cua Moy Frood Tick Size Settlement Price vak
v Adto Amange |
Thcl Walue
v G
Fage Value
x |
Bid Ask Spread Daily Change
1.06025 1.06028 3 -0.02%
22865 1.2287 6 0.01%
0.90306 0.90313 7 -0.18%
148.683 148.689 6 -0.01%
170

Here spread GBPUSD = 6 so, set Maximum Spread Filter =3 x 6 = 18.

This will help you find average spreads: https://www.myfxbook.com/forex-broker-spreads
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Optimized Results Examples

USDJPY,

Date: 01 Jan 2018 — 15 Sep 2023

Deposit: $10,000

Delays : 23ms (only used when Real Ticks selected)

Modelling: On Open Prices

Fixed Inputs : 2 Time Frame = True, Direction = Long Only, Risk percent =1.0% , Middle Period = ignored
n/a, No Day/Time Filters, MAX spread filter 25.

Optimized Inputs:

Highest Period =1 Day, 1Week .
Lowest Period =M30, H1, H2, H3, H4 .
Profit Threshold = 8, 10, 12, 14, 16, 18.

Total of 60 passes.

Pass Result

w haw previous optimization resuls
Preft =

Total trades

21
309
414
385
£5F]
00
155
87

2 passes
5 passes
6 passes

Expected paycff
4T3
£BE.E5

27

27838

Drawdown % Sharpe ratio
33.5% 228
3358 216
3.1
3613

3.57
7.7
3357
5178
13.38

5.20
3357

Ancher_TF
T Wesk
T Week

1 Day
1 Day
10y
T Wieek
1 Wesk
1 Dy
10ay
T Week
T Wesk
T Week
T Wesk
1 Day
1 Dy
T Wesk
T Wesk
1 Wk

Selact crtenon

Second_TF
30 Minutes
30 Minutes
3 Minutes
30 Mintes
30 Minutes
3 Minutes
1 Hour
) Minutes
1 Hour
1 Hour
30 Mintes
1 Hour
30 Minutes
1 Hour
T Hour
30 Minutes
¥ Hour
1 Hour
i} M-nultsi

Profit_Threshald
18
16
3
16
4
14
12
12
12
L7
2
138
L
4
L

-

The top result yielded a profit of $251k from a deposit of $10k, however we need to do a ‘Every Tick
using Real Tick Test’ single Back Test, we will need at least 95% tick data history quality.

Real Tick test with broker historical bid-ask spread:
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USBIPY
P2310% oyrtsstoon

£

Histary Quality wh | ] ~
Bars TS Ticks 280603016  Symbols 1
Initial Deposit 10 000.00
Total Met Profit 251 036.82  EBalance Drawdown Absalute £8371.35  Equity Drewdown Absolute 434240
Gross Profit 45311896 Ealance Drawdewn Maximal 110 338.50 (3345%)  Equity Drawdown Maximal 113 821,28 32.76%)
Gross Loss -224081.34  Balance Drawdown Relative THS9% (12696.52)  Equsty Deswdown Relstive TOEL% (138614TT)
Profit Facter 203 Expected Payoff 37959 Masgin Level 20043T%
Recovery Factor 203 Sharpe Ratio 136 Z-5cone =17.84 {99, 745}
AHPE 10058 (0.38%) LR Correlation 073 OnTester resuht ]
GHPR 1.0052 (0.52%) LR Standard Error ML
Total Trades 608 Shoit Trades [fwon %) 0(0.00%) Long Trades {wan %) 608 (22 BE %)
Total Deals 1216 Profit Trades (% of tokal) 139 (£2.85%)  Loss Trades (% of total) 468 (T7.14%)
Largest prafit trade 3323879 boss trade -3 588.35
Average  profit trade 327423 lossirade =4T2.28
Mezimum 24 [14006.88)  consecutive losses (5) S5 {-2673.20)
Maximal 191 05608 {14) consecutive loss (count) - 109 352.91 (42)
i Lyerage 5 consecutre losses 15
j Entries by hours (Asia Europe,USA) . Eniries by weskdays: 4, Entries by months &
ﬁ iew | Settings | Inputs | Backtest | Graph | Op | Agents | Journal 000807 7 000807 |1 tARE.

Conclusion: $231k profit with, 99% History Quality data, less than $251k open prices modelling. A good
result, using low leverage less than 20-to-1.

e Download the Demo and Repeat the above Optimization, Try it yourself.

NASDAQ -NDX CFD Example

Expet: |ATR_LTDVUTF_NASDAG s v| (e [@
Symbal [NDX v| [M5 < [
Daie | Custom period - PoEoim @ 2 [
Forward: |No ol |
Delays: [Z3ma w| |2 emulste sippage and requotes dumng trade execLbon
Madeling: | Open paces only | [ proft in pepa for faster calculations
Depast 10000 ~| [usD <] 200 <] everace
Optmazation. | Fast genetic based algonthm « Profft Factor max v
g (Pveries Settings 1 Inputs | Backtest | Graph | Ci 5 | nts | Journal 00:05:08 / 000508 | ﬁ_ﬂl
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Variable Value Start Step Step Steps A
[] Expertin Magic Humber 142895 147895 1 1428950 |
- [ 2 TimeFrames Only false | fabie | |true
| [0 Highest Period 1Dy |10y | |1 Weck
| [E Medde Periad - ignored when 2 TimeFrames = true 4 Hours 1 Hour 4 Houirs
[ Lowest Period - must attach EA to this chart 15 Minutes 15 Minutes ' 11 Hour
" Stop Lot Skzes
[ Fixed Lot size e.g 1.32 lots, ignored if ‘Risk % i used 61 ol oot T
[ ‘Riske % per Trade 100 = 1% Risk, 0501z half® 1 [1.0 a1 [100
+ Fixed SDollar Amount, Leave a5 0if not intended to use |
_[] Foxed $Dallar Amount per Trade. 0 0 ! 9 L
¥ =
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Pass Rewl  Profit =  Totaltades  Profitfactor Ecpectedpay. Drawdown% FRecoveryfact.  Sharpe ratio FistTF SecondTF  Profit Threshold *
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We select top result $46k profit for Real Tick Back Test:

= A R LT —
i Expet. |RTR_LTDWITF_NASDAG 5 _ - ~ [mf i3
Smbat. [NEX -] [us < @
Date: [ dod | e BT 5]
Ferward. [No v [pez00in2 |
Delays: [23ms <] || et spoage and recuctes during rade enscation
Modieling | Every tick based on eal icks | [Jowoft in s for aster caloulations
Depost: 10000 | [usp - 120 | leverage
stk genetc bsed st < o o v

Orerviews | Settings I Inputs | Bscktest | Graph | Optimization Results | Agents | foumal

0508 / 00508 [N Sk
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Dy Cest 96% Croality

EREN RARMN

= YTET)

oY)

mas  ALm

00308/ 00d [N

* [ Histary Quality % ML —— -
Bars 3MIT Ticks 290432311 Symbols 1
Initiz| Depost 10 000,00
Tatal Met Profit 4471183 Balance Drawdown Absolute 146899  Equity Drawdown Absolute 151040
Gross Prefit 12507530 Balance Deawdown Maxomal 12071.80(18.08%)  Equity Drawdewn Maximal 14 839,72 (21.48%)
Gross Loss -B1 263.41 Balance Drawdown Relatroe 36.36% (b 60T.62) Equity Drawdown Relative 40.92% (14 780.34)
Profit Factor 1.55 Expected Payoff 108.52 Margin Level 1575.22%
Recovery Factor 3001 Sharpe Ratio 1.76 Z-5core 14,52 (99.74%)
AHPR 1.0045(045%) LR Correlation 089 OnTester result ]
GHPR V004 (0413 LR Standard Error 6 287.66
Total Trades 412 Short Trades (wan %) 0 [0.00%) Long Trades {won %) 412 {25.24%)
Total Deals 824 Profit Trades (% of totad) M [25.24%)  Loss Trades (% of totad) 308 (74.76%)

Largest  profit trade 531433 losstrade 84703
Average  profit trade 13130 losstrade 261,85
Maismurm BB 14ETY)  consecutive lasses (5) & {-6 529.09)

i Mazxirmal 1814671 ({13)  consecutive loss [count) =12 &8 (15}

!- Average 5 consecutive losses 13

E. Oreerview | Seftings Backtest I Geaph | Op ation Results | Agents | Jourmal OE05:08 [ 000508

Conclusion: Real Tick was less than S$46k vs $44k profit, a good result.
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How to setup EA with a Windows Server VPS
Windows Server 2012/2019/2022

Summary: Windows Server 2012 — is like Windows 7 PC, Windows Server 2019/2022 — is like Windows

10 PC.

| use ForexVPS.net, FTMO users can get 20% off, one must log in to FTMO for this and get the discount

code from User Area.

My Affiliate link: https://www.forexvps.net/?aff=47433

| also recommend https://www.mgl5.com/en/vps, fastest ping.
Download and Install your MT5 like you would on a Windows 10/11 PC.

ﬂ 4000017480 - Darwinex-Live - Hedge - Darwinex - AUDJPY,M15
File  View Inset Charts QRCIIE Window  Help

R 4| ¢ = S & [} New Order F9| H4 DI W1 MN

v - IZI + [B IDE @ | () Strategy Tecter Agents Manager F6 hn | @ BB |42l e &

A . IE-—: MetaQuotes Language Editor F4 I5 = d
B3 Task Manager F2 i

‘e Global Variables

. —

Copy my Settings:

MTS5 Terminal > Tools> Options > Charts

Options ? *
Server CharlS Trade ExpertAdvisors OpenCl Events MNotfications Emad FTP Community Signals

[ chart eslor peint
| Show trade history
[l show trade levels
Disabie dragging of trade levels =

[#]Preioad chart data for open positions and orders
[[Ishow olject propertes after creaton
[ select object by single mouse cick
[]Precsa time scais
] select obsect after craation

Magnet sensitvity; | 10 o

Max bars in chart: | 200000

=

MT5 Terminal > Tools> Options > Expert Advisors
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Options ? x

Server Charts Trade Expertidisors OpenCL Events Notficaions Emal FIP  Community Signals

[ ASow aigarithmic trading
] Disable aslgorithmic trading when the account has been changed
EA Disable algorithmic trading when the profile has been changed
[Joisable algorithmic trading when the charts symbal or period has been changed
E#] Disable algarithmic trading via external Python API
[ adlow DLL imports: (potentially dangeraus, enable only for trusted applicatons)
[C] bow WebRequest for ksted URL:
| + add new URL e https: fwsew.mal5. com

[

MT5 Terminal > Tools> Options > Server

Options ? x

Server (Chaets Trade Expert Advisors OpenCL Events Motifications Emal FTP  Comenunity Sipnals

Vl

Change
[CJEnabie proxy server PYOXY. ..
[l keep personal settings and data at startup
[CJenatée news
News languages: Change

e

MT5 Terminal > Tools> Options > Community

A
Options 7 A

Server Charts Trade ExpertAdvisors OpenClL Events Notifications Emai FTP  Community Signals

MQL5.community is an offical community of developers and service providers for trading platform users,

Logi: | - |

et | T |
1f you have an account, please login

Speafy services that you want to use in the terminal:

1 [ calendar ] Cotebase
[[] Market Owes
O sionats Orython integration
[ Articles

o ][ conal ][ 4
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Final VPS step:

Once you have all Charts, Time Frames and Symbols you want use in view, go to View>Market Watch>
right click any ticker, click > ‘Hide All’.
This will stop MT5 reading quotes in the background, from tickers/symbols the EA is not trading on.

File  View Insest  Charts  Tools  Window b
s w [Z] IDE (i3 Algo Trading |4
M1 MS MIS M30D | HT | 4 D1 Wi MN

[Market Wokch; 15:33:11
Symbel = Bid Ask  Spread |

* B New Order -i.
USDCHF Chart Window
UsSoapy - Tick Chan
L = Depth Of Market Ah«B |
= specification
[&] Popup Prices F10 |
Hide All |
Symibois Crrl+ll I

Sets »

MT4/5 AUTO START for VPS:

. | am using ForexVPS.net, and they have this feature, where you can use
’ ' their .exe program to Auto-Start all of your MT4/5 Terminals every
I | time the server restarts. Remember You will have to restart your
Recycle Bin Server every now and then, but also your VPS provider will restart

servers for maintenance.

. You will have to enable this manually by reading the steps in the .ODT
Lt ' text file (usually on the Desktop).

MT
Autostart.odt

Other Forex VPS providers also have this feature (nearly all of them).

E} You won’t need to do this if you have a server provided by
i = etaQuotes from MQL5.com .

Do not use a Linux server with MT4/5.
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Resources
RetailTradingRealities.com
I have no affiliation with the following, just value their content.

https://www.trendfollowing.com/
Author Michael Covel, is the historian and a devoted champion of Trend Following.

https://alphaarchitect.com/2015/08/avoiding-the-big-drawdown-with-trend-following-investment-
strategies/
Alpha Architect article on trend following and diversification, Wesley Gray, PhD

https://www.cis.upenn.edu/~mkearns/finread/trend.pdf
Cole Wilcox, Eric Crittenden, Blackstar Funds, LLC, Does Trend Following Work on Stocks? (TLDR: Yes)

https://www.youtube.com/@Darwinexchange
Darwinex, UK FCA broker, Martyn Tinsley, has the best algo optimization series on YouTube.

https://www.mql5.com/en/articles
Keep up to date with the latest libraries and features of MT5.

https://www.youtube.com/@FinancialWisdom
A retail trend follower, he reads a lot of Finance books and presents a bite-size summary.
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